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Abstract

Age-related macular degeneration (AMD) is a debilitating retinal disorder in aging populations. 

It is widely believed that dysfunction of the retinal pigmented epithelium (RPE) is a key 

pathobiological event in AMD. To understand the mechanisms that lead to RPE dysfunction, 

mouse models can be utilized by researchers. It has been established by previous studies that mice 

can develop RPE pathologies, some of which are observed in the eyes of individuals diagnosed 

with AMD. Here, we describe a phenotyping protocol to assess RPE pathologies in mice. This 

protocol includes the preparation and evaluation of retinal cross-sections using light microscopy 

and transmission electron microscopy, as well as that of RPE flat mounts by confocal microscopy. 

We detail the common types of murine RPE pathologies observed by these techniques and ways 

to quantify them through unbiased methods for statistical testing. As proof of concept, we use 

this RPE phenotyping protocol to quantify the RPE pathologies observed in mice overexpressing 

transmembrane protein 135 (Tmem135) and aged wild-type C57BL/6J mice. The main goal of this 

protocol is to present standard RPE phenotyping methods with unbiased quantitative assessments 

for scientists using mouse models of AMD.

Introduction

Age-related macular degeneration (AMD) is a common blinding disease that affects 

populations over the age of 551. Many researchers believe that dysfunction within the 

retinal pigmented epithelium (RPE) is an early and crucial pathobiological event in AMD2. 

The RPE is a monolayer of polarized cells tasked with maintaining the homeostasis of 

neighboring photoreceptors and choroidal blood vessels3. A variety of models exist to 
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investigate disease-associated mechanisms within the RPE, including cell culture models4,5 

and mice6,7,8. A recent report has described standardized protocols and quality control 

criteria for RPE cell culture models4, yet no report has attempted to standardize the 

phenotyping of the RPE in mouse models. In fact, many publications on mouse models 

of AMD lack a complete description of the RPE or quantification of the RPE pathologies in 

them. The overall goal of this protocol is to present standard RPE phenotyping methods with 

unbiased quantitative assessments for scientists using AMD mouse models.

Previous publications have noted the presence of several RPE pathologies in mice through 

three imaging techniques. For instance, light microscopy allows researchers to view the 

gross morphology of the murine retina (Figure 1A) and detect RPE pathologies such 

as RPE thinning, vacuolization, and migration. RPE thinning in an AMD mouse model 

is exemplified by a deviation in the RPE height from their respective controls (Figure 

1B). RPE vacuolization can be divided into two separate categories: microvacuolization 

(Figure 1C) and macrovacuolization (Figure 1D). RPE microvacuolization is summarized 

by the presence of vacuoles in the RPE that do not affect its overall height, whereas 

macrovacuolization is indicated by the presence of vacuoles that protrude into the outer 

segments of the photoreceptors. RPE migration is distinguished by the focal aggregate of 

pigment above the RPE monolayer in a retinal cross-section (Figure 1E). It should be noted 

that migratory RPE cells in AMD donor eyes exhibit immunoreactivity to immune cell 

markers, such as cluster of differentiation 68 (CD68)9, and could represent immune cells 

engulfing RPE debris or RPE undergoing transdifferentiation9. Another imaging technique 

called transmission electron microscopy can permit researchers to visualize the ultrastructure 

of the RPE and its basement membrane (Figure 2A). This technique can identify the 

predominant sub-RPE deposit in mice, known as the basal laminar deposit (BLamD) 

(Figure 2B)10. Lastly, confocal microscopy can reveal the structure of RPE cells through 

imaging RPE flat mounts (Figure 3A). This method can uncover RPE dysmorphia, the 

deviation of the RPE from its classic honeycomb shape (Figure 3B). It can also detect RPE 

multinucleation, the presence of three or more nuclei within an RPE cell (Figure 3C). For a 

summary of the types of RPE pathologies present in current AMD mouse models, we refer 

researchers to these reviews from the literature6,7.

Researchers studying AMD should be aware of the advantages and disadvantages of 

using mice to investigate RPE pathologies prior to the phenotyping protocol. Mice are 

advantageous because of their relatively short life span and cost-effectiveness, as well 

as their genetic and pharmacologic manipulability. Mice also exhibit RPE degenerative 

changes, including RPE migration, dysmorphia, and multinucleation, that are observed 

in AMD donor eyes11,12,13,14,15,16,17; this suggests that similar mechanisms may underly 

the development of these RPE pathologies in mice and humans. However, there are key 

differences that limit the translatability of mouse studies to human AMD. First, mice do 

not have a macula, an anatomically distinct region of the human retina necessary for 

visual acuity that is preferentially affected in AMD. Second, some RPE pathologies in 

mice, like RPE thinning and vacuolization, are not typically seen in AMD donor eyes18. 

Third, mice do not develop drusen, a hallmark of AMD pathology19. Drusen are lipid- 

and protein-containing deposits with very few basement membrane proteins that form 

between the RPE basal lamina and the inner collagenous layer of Bruch’s membrane 
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(BrM)19. Drusen differ from BLamD, the common sub-RPE deposit in mice, in both their 

composition and anatomical location. BLamDs are age- and stress-dependent extracellular 

matrix-enriched abnormalities that form between the RPE basal lamina of BrM and the 

basal infoldings of the RPE20. Interestingly, BLamDs have a similar protein composition and 

appearance in both mice and humans6,10,21. Recent work suggests BLamDs may act in the 

pathobiology of AMD by influencing the progression of AMD to its later stages18,22; thus, 

these deposits may represent diseased RPE in the mouse retina. Knowledge of these benefits 

and limitations is critical for researchers interested in translating results from mouse studies 

to AMD.

In this protocol, we discuss the methods to prepare eyes for light, transmission electron, 

and confocal microscopy to visualize RPE pathologies. We also describe how to quantify 

RPE pathologies in an unbiased manner for statistical testing. As proof of concept, 

we utilize the RPE phenotyping protocol to investigate the structural RPE pathologies 

observed in transmembrane protein 135- (Tmem135) overexpressing mice and aged wild-

type (WT) C57BL/6J mice. In summary, we aim to describe the phenotyping methodology 

to characterize the RPE in AMD mouse models, since there are currently no standard 

protocols available. Researchers interested in examining and quantifying pathologies of the 

photoreceptors or choroid, which are also affected in AMD mouse models, may not find this 

protocol useful for their studies.

Protocol

All procedures involving animal subjects have been approved by the Institutional Animal 

Care and Use Committee at the University of Wisconsin-Madison, and are in adherence with 

the Association for Research in Vision and Ophthalmology (ARVO) Statement for the Use 

of Animals in Ophthalmic and Vision Research.

1. Evaluation of mouse RPE by light microscopy

1. Make a fixative buffer that has a final concentration of 2% paraformaldehyde and 

2% glutaraldehyde at room temperature (RT) in a glass bottle.

NOTE: This protocol requires, at most, 14 mL of fixative buffer per mouse.

CAUTION: Paraformaldehyde and glutaraldehyde are hazardous substances. 

Please follow the standard operating procedures when working with these 

substances.

2. Prepare a gravity-feed perfusion system on an absorbent underpad for cardiac 

perfusion in a fume hood (Supplementary Figure 1A).

1. Place 40 mL of the fixative buffer into the syringe barrel of the 

perfusion system (Supplementary Figure 1B).

2. Turn the valve until it is parallel with the tubing line to allow the buffer 

to flow through the tubing line (Supplementary Figure 1C). Flush the 

line with buffer until all air bubbles are removed from the line.
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3. Turn the valve until it is perpendicular to the tubing line to stop the 

buffer from flowing into the tubing line (Supplementary Figure 1D).

NOTE: The perfusion system is now ready for use.

3. Euthanize the mouse by placing it into a carbon dioxide (CO2) chamber and 

allow CO2 to flow into the chamber at a flow rate of 30% of the chamber volume 

per minute. Once the mouse stops breathing, allow CO2 to flow into the chamber 

for at least 1 min. Verify the mouse is dead before moving forward to the next 

step.

NOTE: Euthanasia through injection of pharmacological agents can be used in 

this protocol as an alternative to CO2 inhalation.

4. Perform cardiac perfusion on the euthanized mouse.

1. Transfer the mouse to a shallow tray near the perfusion system with its 

abdomen facing up. Spray the abdomen with 70% ethanol (EtOH).

2. Make four incisions to expose the abdominal cavity (Supplementary 

Figure 2A).

1. Create a 5 cm inferior cut using curved scissors and forceps 

through the skin and abdominal wall on the furthest left side of 

the mouse that is directly below the rib cage.

2. Proceed to make a 3 cm medial cut through the skin and 

abdominal wall of the mouse that begins at the top of the 

inferior cut.

3. Make another 5 cm inferior cut at the end of the medial cut 

through the skin and abdominal wall on the furthest right side 

of the mouse directly below the rib cage.

4. Make another 3 cm medial incision to remove the abdominal 

skin flap with curved forceps.

3. Cut through the diaphragm and sternum to expose the heart 

(Supplementary Figure 2B).

NOTE: Be careful to avoid nicking the heart, arteries, and veins. 

Nicking these will lead to an inefficient cardiac perfusion.

4. Insert the gauge needle into the left ventricle of the heart. Turn the valve 

until it is parallel with the tubing line. Cut the right atrium with curved 

scissors to allow blood and fixative to exit the heart (Supplementary 

Figure 2C).

5. Allow 10 mL of fixative buffer to penetrate the mouse for at least 1–2 

min, or until the liver becomes pale in color and no blood flows out of 

the right atrium. Once perfusion is complete, turn the valve until it is 

perpendicular to the tubing line to stop the flow of the buffer.

5. Enucleate the eyes from the mouse after cardiac perfusion.
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1. Remove the mouse from the shallow tray and place the mouse on the 

absorbent underpad in a fume hood. Orient the head of the mouse such 

that the left eye is facing the experimenter and the right eye is out of 

view. Annotate the superior side of the eye with a tissue marking dye.

2. Gently push down with the thumb and index finger around the 

eye socket to cause protrusion of the eye from the eye socket 

(Supplementary Figure 3A).

3. Take curved scissors and hold it with the blade at a 30° angle from the 

eye socket. Proceed to cut around the eye with the curved scissors at a 

30° angle (Supplementary Figure 3B).

NOTE: It is okay to cut excess tissue from the eye socket to preserve 

the integrity of the eyeball.

4. Remove the eyeball from the head with curved forceps and place it on 

an absorbent underpad. Nick the cornea with a number 11 scalpel blade 

and place the eye with curved forceps into a 2 mL microtube with 2 mL 

of fixative buffer. Label the 2 mL microtube with mouse identification 

and ‘left’ to indicate the left eye.

NOTE: The nick in the cornea allows for the fixative to readily 

penetrate the eye to better preserve it.

5. Repeat steps 1.5.1–1.5.4 for right eye.

6. Allow the eyes to incubate in fixative buffer overnight on a shaker in a 4 

°Celsius (C) room, at a speed of 75 rotations per minute (rpm).

7. Replace the fixative buffer with 2 mL of 1x phosphate buffer saline 

(PBS). Incubate the eyes in 1x PBS for 10 min on a shaker at RT and 75 

rpm. Repeat this step twice.

8. Clean and dissect the eyes to generate posterior segments.

NOTE: The posterior segment is the mouse eyeball with the neural 

retina, RPE, choroid, and sclera sans the cornea, iris, and lens.

1. Place eye into a Petri dish filled with 1x PBS under a 

dissecting microscope (Supplementary Figure 4A).

2. Gently lift any fat and muscle away from the eyeball with fine-

tipped forceps. Carefully trim the fat and muscle with micro-

dissecting scissors in a parallel direction to the eyeball until 

the eyeball has a uniform bluish-black color (Supplementary 

Figure 4B).

NOTE: Do not cut in a perpendicular direction, as this 

damages the eyeball. Also, if the tissue marking dye comes off 

during processing, reannotate the superior side of the eyeball 

immediately.
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3. Place fine-tipped forceps at the corneal puncture site. Cut 

around the perimeter of the cornea, beginning at the puncture 

site, with micro-dissecting scissors, to remove the cornea and 

iris from the eyeball (Supplementary Figure 4C).

4. Take fine-tipped forceps and gently remove the lens from the 

eyeball to yield the posterior segment (Supplementary Figure 

4D).

5. Place the posterior segment back into a 2 mL microtube with 

2 mL of 1x PBS. Store the posterior segment in a 4 °C 

refrigerator.

NOTE: Posterior segments can remain in 1x PBS at 4 °C for 

many weeks before further processing.

9. Repeat steps 1.3–1.8 to prepare the eyes from other mice in the study.

10. Process and embed one of the posterior segments from each mouse 

in paraffin for sectioning. Make sure the superior side of the posterior 

segment is on top.

NOTE: The authors rely on the University of Wisconsin-Madison (UW) 

Translational Research Initiatives in Pathology (TRIP) laboratory to 

perform these tasks. Here are published protocols using a similar 

paraffin processing and embedding method23,24.

11. Trim and section each paraffin block to obtain a 5 μm thick retinal 

section that includes the optic nerve head, as well as four additional 5 

μm thick retinal sections that are 250 μm apart from each other. Label 

the slides with mouse identification and the serial section number (i.e., 

1, 2, 3, 4, or 5). Store the slides in a slide box.

NOTE: The authors rely on the UW TRIP laboratory for their services 

in paraffin sectioning. Here are published protocols using similar 

paraffin sectioning method25,26.

12. Stain the slides containing retinal sections with hematoxylin and eosin 

(H&E). A protocol of H&E staining can be found in Supplementary 

Figure 5.

NOTE: All steps of the H&E staining procedure must be completed in a 

fume hood.

13. Collect stitched images of H&E-stained retinal sections with a scale bar 

using a light microscope at 20x magnification.

14. Quantify the RPE thickness in the retinal images containing the optic 

nerve head for each sample.

1. Download and open the Fiji ImageJ program. Drag all the 

stitched retinal images containing the optic nerve head into the 
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Fiji ImageJ taskbar. Verify the image scale is calibrated in μm 

and not pixels.

NOTE: The image scale is located in the upper lefthand 

corner of the window containing a retinal image in the Fiji 

ImageJ program. If the scale is set in pixels, please refer to 

the instruction manual of the Fiji ImageJ program to convert 

pixels to μm.

2. Mark every 300 μm interval in each image from the edge of 

the optic nerve head to the end of the retina (ora serrata). Click 

on the Straight icon in the Fiji ImageJ taskbar. Click and drag 

a line from the edge of the optic nerve head toward the ora 

serrata that is 300 μm in length. Click on the Paintbrush tool 

in the Fiji ImageJ taskbar and click the end of the 300 μm line 

to mark it.

3. Measure the RPE thickness at each marked interval. Click on 

the Straight icon in the Fiji ImageJ taskbar. Click and drag 

a line from the top to the bottom of the RPE (Supplementary 

Figure 6). Click on Analyze > Measure in the Fiji ImageJ 

menu bar to obtain the RPE thickness.

4. Transfer the RPE thickness measurements to a spreadsheet 

and label the column containing measurements with mouse 

identification. Label an additional column with ‘Marked 

Interval’ and enter the distance away from optic nerve values 

(i.e., 300, 600, 900, etc.)

NOTE: The first measured interval corresponds to 300 μm 

away from the optic nerve, the second measured interval 

corresponds to 600 μm away, and so on.

15. Quantify RPE pathology incidence rates based on the retinal images for 

each sample.

1. Open the Fiji ImageJ program.

2. Open the Cell Counter application within the Fiji ImageJ 

program. Click on Plugins > Analyze > Cell Counter in 

the Fiji ImageJ menu bar. Drag a retinal image into the Fiji 

ImageJ taskbar and click on Initialize in the Cell Counter 
window.

3. Count the number of RPE pathologies per retinal section 

using the Cell Counter application. Click on Type 1 under 

Counters and then click on all microvacuolization events in 

the image. Click on Type 2 under Counters and then click 

on all macrovacuolization events in the image. Click on Type 
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3 under Counters and then click on all individual migration 

events in the image.

4. Transfer the numbers of the RPE pathologies to a 

spreadsheet. Label the rows with either microvacuolization, 

macrovacuolization, or migration, and the column with mouse 

identification.

5. Repeat steps 1.15.2–1.15.4 for other images of the sample. 

Average the number of RPE pathologies per sample and divide 

by five to calculate the incidence rate of each RPE pathology 

for the sample in the spreadsheet.

16. Perform statistical analysis on the RPE thicknesses at each interval and 

the RPE pathology incidence rates to determine if there are significant 

differences between groups in the study.

2. Evaluation of mouse RPE by transmission electron microscopy

1. Cut the other posterior segments yielded after steps 1.5–1.9 in half through the 

superior mark into two sections with a razor blade. Reannotate the superior 

side of the sectioned posterior segments with tissue marking dye. Separate the 

sectioned posterior segments into new 2 mL microtubes containing 2 mL of 1x 

PBS and mouse identification.

NOTE: The mouse posterior segment is too large to process in one piece and 

must be cut in half for transmission electron microscopy processing.

2. Rinse the tissues with 2 mL of 0.1 M cacodylate buffer, pH 7.2. Incubate for 10 

min at RT on the benchtop. Repeat this step two more times.

3. Replace the 0.1 M cacodylate buffer with 2 mL of 2% osmium tetroxide (OsO4) 

diluted in 0.1 M cacodylate buffer. Incubate for 1.5 h at RT in the fume hood.

CAUTION: OsO4 is a poisonous substance. Please follow standard operating 

procedures when working with OsO4.

4. Rinse the tissues with 2 mL of 0.1 M cacodylate buffer for 10 min at RT in the 

fume hood. Repeat this step once.

5. Dehydrate the tissues with graduated EtOH dilutions ranging from 50% to 100% 

at RT in the fume hood. A protocol for the dehydration procedure can be found 

in Supplementary Figure 7.

6. Remove 100% EtOH from the tissues and add 2 mL of propylene oxide to 

tissues. Incubate at RT in the fume hood for 15 min. Remove the propylene oxide 

from the tissues and add 2 mL of fresh propylene oxide to the tissues. Incubate at 

RT in the fume hood for 15 min.

CAUTION: Propylene oxide is a toxic substance. Please follow standard 

operating procedures when working with propylene oxide.
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7. Remove propylene oxide from the tissues and add 2 mL of a 1:1 mixture of 

propylene oxide and resin to the tissues. Leave overnight under a vacuum in the 

fume hood at RT.

CAUTION: Resin is a hazardous substance to humans. Please follow the 

laboratory’s standard operating procedures when working with resin.

8. Replace the 1:1 mixture of propylene oxide and resin from tissues with 2 mL of 

pure resin. Leave overnight under a vacuum in the fume hood at RT.

9. Embed the tissues in resin. Place a label with mouse identification in pencil and a 

drop of resin into the mold . Position the tissue on the drop of resin. Fill the mold 

with resin and place under a vacuum for 1 h at RT in the fume hood.

10. Reposition the labels and specimens with fine-tipped forceps, with the posterior 

side of the posterior eyecup section on top. Leave the mold overnight at 65 °C in 

an oven in the fume hood.

11. Remove the molds from oven. Allow the molds to cool to RT on the benchtop. 

Remove the blocks from the molds.

NOTE: The blocks are now ready for trimming.

12. Shape the resin blocks with a razor blade to form a trapezoid. Trim the resin 

blocks using a microtome until the optic nerve head is visible. Proceed to use a 

diamond knife to cut semithin sections from the resin blocks with a thickness of 

0.5 μm.

NOTE: Here is a published protocol on microtome sectioning27. If desired, 0.5 

μm thick semithin sections from the resin blocks can be collected and stained to 

evaluate the integrity of the sample.

13. Cut a 70 nm thick ultrathin section from each trimmed block using an 

ultramicrotome. Collect a 70 nm thick ultrathin section on a 400-mesh thin-bar 

copper grid. Place the grid into a grid storage box and label the slot with mouse 

identification.

NOTE: Here is a published protocol on ultramicrotome sectioning28.

14. Stain the grids with 2% uranyl acetate for 5 min and then with 3.5% lead citrate 

solution for 5 min at RT in the fume hood.

CAUTION: Uranyl acetate and lead citrate are hazardous substances. Please 

follow standard operating procedures when working with these substances.

15. Obtain images for each sample using a transmission electron microscope at a 

magnification of 15,000x, where the grid lines of the copper grid intersect the 

RPE and BrM.

NOTE: There should be at least 20 to 35 images per section and 40 to 70 images 

per sample.

16. Quantify BLamD heights in the images for the samples in the study.
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1. Open the Fiji ImageJ program. Drag all images from the sample section 

into the Fiji ImageJ taskbar. Verify that the images are calibrated in μm 

and not pixels.

2. Measure the BLamD height in the images. Click the Straight icon in 

the Fiji ImageJ taskbar. Click and drag a line from the elastic lamina 

of BrM to the top of the tallest deposit in the image (Supplementary 

Figure 8). Click Analyze > Measure in the Fiji ImageJ menu bar to 

obtain the BLamD height in the image.

NOTE: If there are no BLamDs in the image, then draw a line from the 

elastic lamina of BrM to the basal lamina of the RPE.

3. Transfer the BLamD heights to a spreadsheet and label with mouse 

identification.

17. Calculate the cumulative frequencies of BLamD heights per genotype and 

averages of BLamD heights per mouse in the spreadsheet. Perform statistical 

analysis on the averages of BLamD heights to determine if there are significant 

differences between groups in the study.

3. Evaluation of mouse RPE through confocal microscopy

1. Collect eyes from the mice. Euthanize the mice according to the procedure 

described in step 1.3. Enucleate the eyes using step 1.5. Place the eyes using 

curved forceps into a 2 mL microtube with 2 mL of 1x PBS and mouse 

identification.

NOTE: Do not dark-adapt the mice, as the interdigitization of the photoreceptors 

and RPE apical processes allows for better visualization of the RPE through 

confocal microscopy.

2. Clean and dissect the mouse eyes immediately to generate mouse posterior 

eyecups.

NOTE: The posterior eyecup is different from the posterior segment because it 

does not contain the neural retina.

1. Transfer the eye to a Petri dish containing 1x PBS under a dissecting 

microscope (Supplementary Figure 9A).

2. Remove fat and muscle from the eyeball, as described in step 1.8.2 

(Supplementary Figure 9B).

3. Nick the cornea of the eyeball with a number 11 scalpel blade. Remove 

the cornea and iris, as detailed in step 1.8.3 (Supplementary Figure 9C).

4. Pull out the lens with fine-tipped forceps. Take two fine-tipped forceps 

and gently separate the neural retina from the posterior segment.

5. Carefully cut the neural retina at the optic nerve head for removal from 

the posterior eyecup (Supplementary Figure 9D).
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6. Place the posterior eyecup into a new 2 mL microtube containing 500 

μL of 1x PBS with mouse identification.

3. Fix the posterior eyecups with methanol (MeOH) (Supplementary Figure 10).

NOTE: Step 3.3 takes about 2 h and 40 min to complete.

1. Add 500 μL of MeOH to tissues. Incubate on a shaker at 75 rpm for 5 

min at RT.

2. Remove the 500 μL of solution from the tissues and add 500 μL of 

MeOH. Incubate for 5 min on a shaker at 75 rpm for 5 min at RT. 

Repeat this step one more time.

3. Remove the entire solution from the tissues and add 500 μL of MeOH. 

Incubate on a shaker at 75 rpm for at least 2 h at RT.

NOTE: As an alternative to step 3.3.3, the posterior eyecup can be 

incubated overnight in MeOH on a shaker at 75 rpm in a 4 °C room.

4. Add 500 μL of 1x PBS to the tissues. Incubate on a shaker at 75 rpm for 

5 min at RT.

5. Remove the 500 μL of solution from the tissues and add 500 μL of 1x 

PBS. Incubate on a shaker at 75 rpm for 5 min at RT. Repeat this step 

one more time.

6. Remove the entire solution from the tissues and replace it with 500 μL 

of 1x PBS.

NOTE: The tissues are fully fixed by the MeOH and can be kept in a 4 

°C refrigerator for at least 1 month.

4. Perform immunofluorescence staining of the posterior eyecups to visualize tight 

junctions and nuclei of the RPE (Supplementary Figure 11).

1. Remove the 500 μL of 1x PBS from samples and add 100 μL of diluted 

10% normal donkey serum in 1x PBS solution. Incubate on a shaker at 

75 rpm for 30 min at RT.

2. Remove the diluted 10% normal donkey serum solution from the 

samples and add 100 μL of a 1:50 dilution of a rabbit polyclonal anti-

Zonula Occludens-1 (ZO-1) antibody in 1x PBS. Transfer the samples 

to a 4 °C room and incubate overnight on a shaker at 75 rpm.

3. Remove the antibody dilution from the samples and add 2 mL of 1x 

PBS. Incubate on a shaker at 75 rpm for 10 min at RT. Repeat this step 

two more times.

4. Remove the 1x PBS from samples. Add 100 μL of a 1:250 dilution of a 

donkey anti-rabbit IgG antibody with a 488 fluorophore-conjugated tag 

and a 1:250 dilution of 4’,6-Diamidine-2’-phenylindole dihydrochloride 

(DAPI) in 1x PBS to the samples. Cover the samples with aluminum 

foil and incubate on a shaker at 75 rpm for 2 h at RT.
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NOTE: The samples must be completely covered with aluminum foil to 

prevent photobleaching.

5. Remove the antibody and DAPI dilutions from the samples. Add 2 mL 

of 1x PBS to the samples, recover with aluminum foil, and incubate on 

a shaker at 75 rpm for 10 min at RT. Repeat this step three more times.

NOTE: The tight junctions and nuclei of the RPE are now fully labeled 

and stained, respectively.

5. Mount the posterior eyecups onto microscope slides.

1. Label a microscope slide with mouse identification. Transfer the 

posterior eyecup onto a microscope slide under a dissecting microscope 

with the choroidal side facing down. Add a drop of 1x PBS to the 

posterior eyecup to prevent it from drying out (Supplementary Figure 

12).

2. Cut the posterior eyecup using a number 11 scalpel blade at four spots 

that will yield four quadrants corresponding to the cardinal directions 

(i.e., north, east, south, and west). Dab excess 1x PBS with the 

perimeter of the posterior eyecup. Gently flatten the posterior eyecup 

with a camel hairbrush and fine-tipped forceps (Supplementary Figure 

12).

NOTE: The resulting product is now known as an RPE flat mount.

3. Add a drop of mounting medium to the RPE flat mount and place a 

coverslip on top of it. Apply clear fingernail polish to seal the coverslip 

and allow it to dry for at least 30 min at RT in a closed drawer. Place the 

slides in a slide carrier box and keep the box in a 4 °C refrigerator.

NOTE: Be careful to avoid introducing bubbles on the RPE flat mount. 

RPE flat mounts can be imaged within a 2 week time frame.

6. Obtain an image of each of the four quadrants surrounding the optic nerve of the 

RPE flat mount on a confocal microscope at 20x magnification for each sample. 

An example of an RPE flat mount image can be found in Supplementary Figure 

13A.

NOTE: It may be necessary to perform z-stack imaging of the RPE flat mounts 

where multiple images are taken and stacked to compensate for dimensional 

differences of the RPE flat mount.

7. Trace the tight junctions of the RPE cells within each RPE flat mount image. 

An example of a traced RPE flat mount image can be found in Supplementary 

Figure 13B.

1. Open the Fiji ImageJ program. Drag an RPE flat mount image into the 

Fiji ImageJ taskbar. Verify the image is calibrated in micrometers and 

not pixels.
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2. Double-click on the Overlay Brush Tool icon in the Fiji ImageJ 

taskbar to set the brush width to 3, transparency to 0, and color to 

red. Click the Close button in the Overlay Brush Tool window.

3. Click on the Overlay Brush Tool icon. Click and drag on the tight 

junctions of all RPE cells that are completely within the image.

NOTE: In case a tracing mistake is made, double-click on the Overlay 
Brush Tool icon and click the Undo box in the Overlay Brush Tool 
window to remove the tracing mistake from the image.

4. Click the Rectangle icon in the Fiji ImageJ taskbar. Click on the image 

and drag around the perimeter of the image. Click Edit > Clear on the 

Fiji ImageJ menu bar to keep the traced lines and remove any blue and 

green colors from the image.

5. Save the trace image in an appropriate location with mouse 

identification, quadrant location (i.e., north, south, east, or west), and 

a CP suffix label.

NOTE: Do not save the RPE trace image prior to completing step 3.7.4.

8. Calculate the RPE cell areas for each sample.

1. Designate a location to save the files from RPE area analysis by 

creating a folder on the computer desktop screen. Generate subfolders 

for each RPE trace image and label the subfolders with mouse 

identification as well as quadrant location (i.e., north, south, east, or 

west).

2. Install and open the Cell Profiler program29. Download the Ikeda_RPE 

Area Calculator.cpproj (Supplementary Coding File 1) project file. 

Open the Ikeda_RPE Area Calculator.cpproj file by clicking File > 
Open Project in the Cell Profiler program menu bar.

3. Drag one RPE trace image into Image > Drop Files and Folders Here 
box in the Cell Profiler program window.

4. Input the location of the folder into the Cell Profiler program that 

corresponds to the RPE trace image. Click on the Output Settings 
button in the bottom left-hand corner of the Cell Profiler program 

window and enter the location of the folder in the Default Input Folder 
and Default Output Folder text boxes.

5. Click on the Analyze Images button in the bottom left corner of 

the Cell Profiler program window. After the analysis is complete, an 

Analysis Complete window will appear on the screen. Click on the OK 
button in the Analysis Complete window.

NOTE: This action will generate a csv file and jpeg image. The csv file 

will contain the areas for the RPE cells within the trace image. The jpeg 
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image will correspond to the RPE trace image, where each RPE cell 

will be labeled with a number (Supplementary Figure 13C).

6. Transfer the RPE areas from the csv file to a spreadsheet. Label the 

spreadsheet with mouse identification.

7. Perform a quality control survey of the data by confirming that each 

RPE area in the csv file links to a fully-traced RPE cell in a jpeg image. 

Remove any values from the spreadsheet that do not correspond to fully 

traced RPE cells.

8. Return to the Cell Profiler program. Right-click on the RPE trace image 

name in the Drop Files and Folders Here box and select Clear the 
List to remove the image from the Cell Profiler program.

9. Repeat steps 3.8.3–3.8.8 to calculate the RPE sizes for the remaining 

three RPE trace images of the sample.

9. Quantify the RPE cell size averages for each sample in the spreadsheet.

10. Quantify the RPE cell densities for each sample in the spreadsheet. To calculate 

the RPE cell density, divide the total number of RPE cells per quadrant 

by the total area of RPE cells per quadrant that was detected by the Cell 

Profiler program. Determine the average of the RPE cell densities from the four 

quadrants per sample.

11. Quantify the number of multinucleated RPE cells per RPE flat mount for each 

sample. Use the Cell Counter application within the Fiji ImageJ program, as 

described in steps 1.15.1–1.15.3, to count the number of RPE cells with more 

than three nuclei in four quadrants of the sample.

12. Perform statistical analysis on the RPE cell size and density averages, as well 

as the number of multinucleated RPE cells to determine if there are significant 

differences between groups in the study.

Representative Results

Completion of the RPE phenotyping protocol described in this article provides a quantitative 

analysis of the structural RPE abnormalities commonly observed in mouse models of AMD. 

To confirm the effectiveness of this protocol, we used it in mice that are known to display 

RPE pathologies, including transgenic mice that overexpress WT Tmem135 driven by the 

chicken beta-actin promoter (Tmem135 TG)30 and aged C57BL/6J mice31,32. The objective 

of these experiments is to show representative results that could be obtained using the 

methods described in this protocol to researchers new to mouse models.

We adhered to the methods in Step 1 of the protocol to process and evaluate eyes from 

WT and Tmem135 TG mice to evaluate RPE pathologies using light microscopy. We found 

that 4-month-old Tmem135 TG mice have a significant reduction in RPE thickness at two 

measured intervals relative to age-matched WT through an ANOVA with post-hoc Tukey 
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test (Figure 4). These results indicate that the RPE is thinner in the 4-month-old Tmem135 
TG mice than in age-matched WT mice at 600 and 900 μm away from the optic nerve.

In addition, utilizing the methods of Step 1 of the protocol, we calculated the incidence 

of RPE pathologies, including microvacuolization, macrovacuolization, and migration of 

three 25-day-old WT and Tmem135 TG mice (Figure 5A). The average frequency of RPE 

microvacuolization pathologies per slide in WT mice was 0.67 ± 0.31 and in Tmem135 TG 

mice was 7.07 ± 0.61 (Figure 5B). There was no RPE macrovacuolization in WT mice, 

but there were, on average, 5.33 ± 2.02 macrovacuolization events in Tmem135 TG mice 

(Figure 5C). Lastly, the rates of migratory RPE cells per slide was zero in WT mice and 0.4 

± 0.35 in Tmem135 TG mice (Figure 5D). After performing a student’s t-test, the incidence 

of RPE microvacuolization and microvacuolization was significantly different between WT 

and Tmem135 TG mice. However, the higher incidence of RPE migratory cells in Tmem135 
TG mice was not significantly different compared to WT (p = 0.1161). This data shows that 

RPE microvacuolization and macrovacuolization, but not migration, is significantly higher 

in 25-day-old Tmem135 TG than WT mice.

Following the methods of the protocol included in Step 2, we prepared retinal sections from 

2-month-old and 24-month-old WT C57BL/6J mice for transmission electron microscopy to 

analyze the presence and heights of BLamDs. We found BLamDs present in 24-month-old 

WT retinas that were notably absent in 2-month-old WT retinas (Figure 6A). We presented 

the heights of the BLamDs in the 24-month-old WT retinas by calculating and plotting the 

cumulative frequencies of their occurrence. Cumulative frequencies of the BLamD heights 

were graphed against deposit height to illustrate the distribution of the deposit heights. There 

is a shift to the right of the line for the 24-month-old WT BLamD heights compared to the 

2-month-old WT BLamD heights, demonstrating an increase of deposits in 24-month-old 

WT mice (Figure 6B). This graph is supported by a larger average of BLamD heights in 

24-month-old WT retinas (1.01 μm ± 0.43 μm) than 2-month-old WT retinas (0.23 μm ± 

0.017 μm), that were significantly different by a student’s t-test (Figure 6C). In summary, 

we conclude that 24-month-old WT mice have large BLamDs in the sub-RPE space of their 

retinas compared to 2-month-old WT mice.

We applied the methods of preparing eyes from 4-month-old WT and Tmem135 TG mice in 

Step 3 to generate RPE flat mounts for the detection and analysis of RPE dysmorphia and 

multinucleation. In this protocol, we defined RPE dysmorphia by changes in RPE cell size 

and density in an AMD mouse model relative to their controls. We found that the RPE in 

4-month-old Tmem135 TG mice are dysmorphic (Figure 7A). The RPE in Tmem135 TG 

retinas are larger (806.89 μm2 ± 252.67 vs. 291.69 μm2 ± 26.31) and less dense (0.0014 

cells/μm2 ± 0.00039 vs. 0.0033 cells/μm2 ± 0.00024) than age-matched WT retinas (Figure 

7B,C). Furthermore, there were more multinucleated RPE cells in the Tmem135 TG retinas 

compared to WT controls (8.04 cells ± 5.54 vs. 0.33 cells ± 0.29) (Figure 7D). All these 

parameters reached statistical significance with a student’s t-test. Together, 4-month-old 

Tmem135 TG mice have more dysmorphic and multinucleated RPE cells than 4-month-old 

WT mice.
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Discussion

In this article, we introduced a phenotyping protocol for assessing the structural RPE 

pathologies of mouse models. We described the steps required for processing the eyes for 

various imaging techniques including light, transmission electron, and confocal microscopy, 

as well as the quantitation of typical pathologies observed via these imaging methods. We 

proved the effectiveness of our RPE phenotyping protocol by examining Tmem135 TG and 

24-month-old WT mice, since these mice display RPE pathologies30,31,32. This protocol can 

be applied to any genetically modified or pharmacologically treated mouse that may harbor 

RPE pathologies such as RPE thinning, vacuolization, migration, and dysmorphia, as well 

as BLamDs6,7. Although the RPE pathologies observed in Tmem135 TG and 24-month-old 

WT mice are present in other AMD mouse models7,30, it is important for the researcher 

to become familiar with the AMD mouse model chosen for their studies, as the age of 

onset and severity of the RPE pathologies of their AMD mouse model may differ from the 

Tmem135 TG and 24-month-old WT mice. Researchers may need to utilize more mice for 

their studies than the numbers of mice used to produce the representative results shown 

in this article, if the presentation of RPE pathologies is variable in their respective AMD 

mouse model. Furthermore, many AMD mouse models are currently available to AMD 

researchers, yet do not have complete descriptions of their RPE pathologies, which may 

require researchers to perform preliminary studies to acquire this information.

Although modifications can be made in how mouse eyes are processed for the various 

imaging methods, it is critical to maintain the quantitative evaluation of structural RPE 

abnormalities as described in the protocol. For instance, five H&E-stained retinal sections 

were prepared to count the number of RPE microvacuolization, macrovacuolization, and 

migration events, allowing researchers to evaluate RPE pathologies at multiple locations in 

the mouse retina. Another example is using a 400-mesh thin-bar copper electron microscopy 

grid to assess the ultrastructural abnormalities of the RPE. The electron microscopy 

grid provides a framework to evaluate a retinal sample systematically and unbiasedly by 

transmission electron micrography, as well as obtain 40 to 70 images per retinal section to 

examine the presence of BLamDs. This cannot be achieved with an electron microscopy-

slot grid, and we suggest not utilizing them with this protocol. Lastly, capturing 20x 

magnification images from the four quadrants of an RPE flat mount enables researchers to 

investigate large areas of murine RPE for dysmorphia and multinucleation. Researchers are 

free to expand on this protocol and examine additional retinal sections for RPE pathologies 

in their studies. Together, these methods allow researchers to gather ample data to make 

conclusions about the structural RPE pathologies that may be present in their AMD mouse 

models.

Another key feature of this protocol is the consistency of the RPE phenotyping methods. For 

example, all eyes used for light and transmission electron microscopy were orientated by the 

superior side of the mouse retina for sectioning. It is important to maintain the orientation 

of the mouse eye throughout its processing for light and transmission electron microscopy 

because the mouse eye has a topographical distribution of retinal cells33,34. The anatomical 

orientation of the mouse eye was not maintained for RPE flat mount preparation, since 

superior to inferior topographical changes of the mouse RPE cell have not been observed. 
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In fact, the RPE in the human retina displays topographical changes that radiate away from 

the optic nerve head35, suggesting this may be the case for mouse RPE. Lastly, the image 

acquisition described in this protocol relies on the anatomical positioning of the optic nerve. 

Inclusion of these methodological aspects will help to reproduce results of RPE pathologies 

for researchers as they work with their AMD mouse models.

Researchers may desire to add more analytical features to the RPE phenotyping protocol. 

Some phenotypic outcomes not featured in this protocol are the examination of BrM 

thickness, RPE apical microvilli, and other RPE ultrastructural components. These 

components include mitochondria, pigment granules, and other organelles like phagosomes. 

Researchers can determine the size and number of these components in the electron 

micrographs obtained with this protocol using the Fiji ImageJ program. In particular, 

the status of mitochondria may be an important phenotypic outcome to consider, since 

targeting mitochondria in the RPE is an important therapeutic strategy for AMD36. Another 

phenotypic outcome is additional measurements of RPE dysmorphia on RPE flat mounts. 

RPE flat mount images obtained using the protocol can be examined for RPE hexagonal 

shape, number of neighboring RPE cells, and other properties with the REShAPE program 

(https://github.com/nih-nei/REShAPE)35. Another possible phenotypic outcome is whether 

RPE pathologies occur in the central or peripheral areas of the mouse retina. These 

additional phenotypic considerations will further strengthen the RPE phenotyping protocol 

described in this article.

There are a few limitations of this RPE phenotyping protocol. One limitation of this method 

is the need to sacrifice mice to harvest their eyes for RPE phenotyping. As an alternative, 

new advances in spectral domain optical coherence tomography (SD-OCT) imaging allow 

for the quantification of RPE thickness and pathologies in living mice37–39. This may be 

advantageous to researchers who want to perform longitudinal studies on their AMD mouse 

model cohorts. Another limitation of this method is the lack of functional RPE assessments 

in mice. If researchers are interested in a functional assessment of the RPE in mice, we 

recommend performing electroretinography and measuring the c-wave component, as the 

c-wave is indicative of the functional role of the RPE in phototransduction40. Another 

limitation of this method is the lack of biochemical measurements of RPE markers in mice. 

If researchers desire to investigate the levels of RPE markers, such as cellular retinaldehyde-

binding protein (CRABLP), retinal pigment epithelium-specific 65 kDa protein (RPE65), 

potassium inwardly rectifying channel subfamily J member 13 (KCNJ13), or bestrophin 1 

(BEST1), we recommend harvesting eyes for immunohistochemistry, quantitative real-time 

PCR, or western blot analysis.

In conclusion, this RPE phenotyping protocol can be an important resource for researchers 

using mouse models recapitulating pathological aspects of AMD. This protocol also serves 

to standardize how the RPE is evaluated in AMD mouse models, which has not been 

previously described in the literature. Standardizing RPE phenotyping would be critical in 

translating the findings from mice to other models of AMD, including RPE cell culture 

models4 and higher organism models including non-human primates. It would also aid in 

our understanding of the pathobiological mechanisms underlying AMD development and 

potentially developing new therapies for this blinding disease.
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Figure 1: RPE pathologies detected by light microscopy.
Representative images of normal RPE in WT (A) and abnormal RPE in Tmem135 TG 

mice (B-E). The RPE pathologies observed in Tmem135 TG mice include RPE thinning 

(B), macrovacuolization (C), microvacuolization (D), and migration (E). Each pathology is 

illustrated by a black arrow. Scale bar = 100 μm. Magnification = 20x. Abbreviations: RGC 

= retinal ganglion cell layer, IPL = inner plexiform layer, INL = inner nuclear layer, OPL = 

outer plexiform layer, ONL = outer nuclear layer, IS = photoreceptor inner segments, OS = 

photoreceptor outer segments, RPE = retinal pigmented epithelium, Cho = choroid. Please 

click here to view a larger version of this figure.
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Figure 2: RPE pathologies detected by transmission electron microscopy.
Representative images of (A) RPE in young CFH-H/H and (B) 2-year-old CFH-H/H mice 

that has abundant basal laminar deposits (BLamDs). BLamDs are traced with yellow dots 

in the image. Scale bar = 800 nm. Magnification = 15,000x. Abbreviations: N = nucleus, M 

= mitochondrion, P = pigment granule, BI = basal infoldings, EL = elastic lamina, RPE = 

retinal pigmented epithelium, BrM = Bruch’s membrane, Cho = choroid. Please click here to 

view a larger version of this figure.
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Figure 3: RPE pathologies detected by confocal microscopy.
Representative images of (A) normal RPE of 8-month-old WT and (B) abnormal RPE of 

8-month-old Tmem135 TG mice that exhibits RPE dysmorphia. The white square is zoomed 

in (C) to depict a multinucleated RPE cell with three nuclei. The green color is anti-ZO1 

associated RPE tight junctions, and the blue color is DAPI staining of RPE nuclei. Scale bar 

= 50 μm. Magnification = 20x. Please click here to view a larger version of this figure.
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Figure 4: RPE thickness in 4-month-old wild-type (WT) and Tmem135 TG mice.
(A) Representative images of the retina from 4-month-old WT and Tmem135 TG (TG) 

mice. Magnification = 20x. Scale bar = 100 μm. (B) Line graphs of the RPE thickness 

measurements in 4-month-old WT (black) and Tmem135 TG mice (green) up to 3,000 μm 

away from the optic nerve. Numbers after the genotype denote the number of mice used 

in this study. *p < 0.05, ANOVA with post-hoc Tukey test. All data are mean ± sd. Please 

see the Figure 1 legend for abbreviations of retinal layers. Please click here to view a larger 

version of this figure.
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Figure 5: RPE pathologies in 25-day-old Tmem135 TG mice.
(A) Representative images of RPE microvacuolization, macrovacuolization, and migration in 

three 25-day-old Tmem135 TG (TG) mice. RPE pathologies are highlighted by black arrows 

in each image. Magnification = 40x. Scale bar = 20 μm. (B-D) Quantification of RPE micro- 

and macrovacuolization as well as migratory RPE cells in 25-day-old WT and Tmem135 TG 

mice. Numbers in parentheses denote the number of mice used in this study. *p < 0.05 and 

****p < 0.0001, student’s t-test. All data are mean ± sd. Please click here to view a larger 

version of this figure.
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Figure 6: Ultrastructural analysis of BLamDs in young and aged WT retinas.
(A) Representative electron micrographs of 2-month-old and 24-month-old WT RPE. 

Magnification = 15,000x. Scale bar = 800 nm. An example of a basal laminar deposit 

(BLamD) is diagrammed with a bracket. (B) Cumulative frequencies of the BLamD heights. 

(C) BLamD height averages. Numbers in parentheses denote the total number of mice per 

genotype used in this study. **p < 0.01, student’s t-test. All data are mean ± sd. Please see 

the Figure 2 legend for abbreviations of retinal layers. Please click here to view a larger 

version of this figure.
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Figure 7: RPE flat mounts reveal RPE pathologies in Tmem135 TG mice.
(A) Representative images of 4-month-old WT and Tmem135 TG (TG) RPE flat mounts 

with anti-ZO-1 in green and DAPI in blue. Magnification = 20x. Scale bar = 100 μm. (B) 

RPE cell size, (C) RPE cell density, and (D) RPE multinucleation in 4-month-old WT and 

Tmem135 TG mice. The number in parentheses denotes the number of mice used in the 

study. *p < 0.05, **p < 0.01 and ****p < 0.0001, student’s t-test. All data are mean ± sd. 

Please click here to view a larger version of this figure.
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